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Customize the Home Screen and the Calendar 

Customize the Home Screen 
 

The Home screen displays when you open the program. It's divided into three sections: 
• Main Menu — Displays lists of information about individuals and groups in the program including classes, 

teachers, families, students, and other individual types. 
• Assistants — Displays a list of tasks you can perform in the program including Adding Students, Posting 

Grades, and Updating Permanent Records. 
• Other — Displays program options and other information about an individual or group. 

 
You can customize the Home screen display on the Customize tab, located at the bottom of the screen. 
To customize the Home screen display, click the Customize tab. Make your selections in the Home Tab section, and 
click OK. 
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Customize the Calendar 
 

You can customize the Calendar display on the Customize tab, located at the bottom of the screen. 
 
To customize the Calendar tab 

1. On the Home screen, click the Customize tab.  
2. Make your display selections in the Display Options section. 
3. Calendar events are indicated by a small graphic image called an event icon. To select an event icon to 

display on your calendar, on the Home screen, click the Customize tab.  
4. Click the Calendar Event Icon drop-down list and select an image. 

 

 

 

  

  

   

Useful Information: Only those with teacher logins will see the Show Assignments and Show Lesson Plans check 
boxes.  
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School Calendar 

Set Up Custom Events and Closing Lists 
 

You can create a custom list of events and closings (such as holidays) to insert into the school calendar. Once created, 
the list is available as an Event list when you insert an event or holiday in the calendar. Setting up custom lists is 
optional because you can add events and closings directly from the school calendar. However, if you take time to 
pre-define these lists, it may save you time later. 
 
To create a list or event 

1. On the Home screen, click Define List.  
2. Under Calendar, click Day Types.  
3. Click Add. 
4. Enter a description of the closing or event. For example, enter Christmas or Science Fair. 
5. In the Type list, select Closed, if the school will be closed. Or, select Events for an important occurrence. 
6. Click OK. 
7. Repeat steps 3 through 6 for each closing event you want to add.  
8. On the Home screen, click Define Lists.  

 
To change an event description or type 

1. On the Home screen, click Define Lists. 
2. Under Calendar, click Day Types. 
3. Double-click the description you want to change. 
4. Change the description or select a new Type. 
5. Click OK. 

 
To remove a description 

1. On the Home screen, click Define Lists. 
2. Under Calendar, click Day Types. 
3. Click to select the description you want to remove. 
4. Click Delete. 
5. When the confirmation message displays, click Yes. 

 

 
 

  

  

   

Useful Information: After you set up custom closing and event lists, you can print a list for reference. Click Print, 
then click the Print icon in the preview window.  
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Create a School Calendar 
 

The School Calendar contains half and full day closings and events, such as the science fair, athletic events, or special 
presentations. You can print the calendar for distribution to students and parents. Additionally, teachers and staff can 
view the calendar when they log in to HeadMaster. 
 
The School Calendar is created using the start and end dates of your grading periods. Before you begin adding events 
or closings to the calendar, check to see that your grading periods are set up properly. For more information, see Set 
Dates for Grading Periods on page 90. 
 
By default, the calendar creates a standard school week (Monday through Friday), where students meet for the same 
classes each day. However, you can reset the school calendar so that it displays a custom start and end date, days of 
the week that you specify, or one that displays block scheduling: Alternate Days (A/B Days) or Alternate Weeks (A/B 
Weeks). If you're setting up your calendar for the first time and know you want to use either A/B Days or A/B 
Weeks, select one of these types first. This will prevent you from having to reset the schedule. 
 
To create a school calendar 

1. On the Tools menu, click School Calendar. The default standard calendar displays.  
2. Add closing and events. See Add Closings, Events, and Half Days on page 9.  
3. In the Type list, select A/B Day or A/B Week. See More about Block Scheduling on the next page. 
4. To save, click OK. 
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More about Block Scheduling 
 

Block scheduling is a type of academic scheduling in which each student has fewer classes per day for a longer period 
of time. The A/B or alternate day plan organizes each day into four 90-minute periods but has a total of eight classes 
meeting over two consecutive days (“A Day” and “B Day”). Another way of distributing classes is to alternate ABABA 
weeks with BABAB weeks. See examples below.  
 
Example of Block Scheduling - A Week 

 

  

Example of Block Scheduling - B Week 

 

  

Example of Block Scheduling - Mixed 
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Reset Calendar Options 
 

Resetting the options erases all data in the current calendar. 
Resetting the calendar options is generally used at the start of a new school year. You can also reset the options 
when you want to change the start and end dates of the calendar, change the specific days of the week that display, 
or switching from a standard calendar to a block scheduled calendar (A/B Days or A/B Weeks). 
 

To reset calendar options 
1. On the Tools menu, click School Calendar. The default standard calendar displays. 
2. With the School Calendar open, click Reset. 
3. Select the Start Date and/or End Date. 
4. Select the Type. 
5. Select the days your school is regularly open. Note that all days of the week display in the calendar. 
6. Click OK. HeadMaster builds the new calendar based on the options selected.  
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Add Closings, Events, and Half Days 
 
After you create a calendar, you can add school closings (half and whole day) and events. You can add these one day 
at a time or you can add a closing or event to an entire week. 

1. On the Tools menu, click School Calendar. 
2. Right-click a date on the calendar and make your selection. 
3. In the Closed or Events menu, select the type of closing (such as Christmas) or the event (such as Science 

Fair) to add to the calendar. 
4. Repeat steps 2 through 3 for each closing or event you want to add. 
5. Click OK. 
6. On the Tools menu, click School Calendar. 
7. Right-click a date on the calendar and make your selection. 
8. Click Half Day. 
9. To reset the day to a standard day, right-click the date and select Standard Day. 

 

 
  

Useful Information: You can also mark the calendar using the tool bar. Click the date on the calendar you want to 
set. On the toolbar, click Standard Day, Half Day, Add by Day, or Add by Week.  
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Remove Events from the School Calendar 
 

You can remove a closing or event from the calendar.  
1. On the Tools menu, click School Calendar.  
2. Right-click a date and click Remove Item. 

 

 
  

Useful Information: If you marked an entire week, you must remove each day individually.  
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Print the School Calendar 
 

There are two ways to print the school calendar. You can print a Calendar View report and a Detail View report. A 
preview of each report displays prior to printing. 

1. On the Tools menu, click School Calendar. 
2. On the toolbar, click Print and select a view. 
3. To print the report, click the Printer icon and click OK.  
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Viewing the School Calendar (Teachers and Staff) 
 

Teachers and staff can only view and print the school calendar. To view the school calendar, on the Tools menu, click 
School Calendar. 
 
For information about printing the calendar, see Print the School Calendar on page 11. For assistance with the 
calendar legend, see Close and Open the Calendar Legend on the next page.  
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Close and Open the Calendar Legend 
 

By default, the legend displays on the school calendar page. To close the legend, click the X. To re-open the Legend, 
on the toolbar, click Show Legend. 
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Use Reminders 

Add Reminders 
 
Reminders are the "sticky notes" in HeadMaster. After you set up reminders, they display on the HeadMaster 
Calendar tab. While Reminders can be added on the Calendar tab, you can also view, add, edit, filter, and print 
reminders from the Reminder List.  

Reminders can be used to notify the following: 
• Individual parent meetings 
• Teacher meetings 
• Parent-teacher conferences 
• Administration meetings 
• Medical appointments 
• Holidays 
• Personal reminders 
• Athletic events 
• Student birthdays  

 
To add reminders 

1. On the Home screen, click Reminders. 
2. Click New. 
3. Enter the name, expiration date, and notes, if any. 
4. Click OK. 
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Delete a Reminder 
 

You can delete a reminder from HeadMaster if it is no longer applicable or has been completed. You can only remove 
reminders from the Reminder List. 

1. On Home screen, click Reminders. 
2. Click to select the reminder you want to delete. 
3. Click Delete. 
4. Click Yes.  
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Edit a Reminder or Mark a Reminder as Completed 
 
You can edit reminders, and you can mark them as completed. 

1. On Home screen, click Reminders. 
2. Double-click the reminder you want to change. 
3. Make the changes and click OK.  
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Make Reminders Public 
 
The ability to make a reminder public is a useful feature for school administrators. When a reminder is made public, it 
displays on the Calendar tab under Reminders. You can use this to remind teachers that grades are due by a specific 
date or of meetings, school functions, or other deadlines. 

1. On the Home screen, click Reminders. 
2. To add a new reminder, click New. To edit an existing reminder, click Edit. 
3. Enter a publish date and an expiration date. 
4. Select the Make Public check box and click OK.  
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Print a List of Reminders 
 
You can preview or print a list of reminders from the Reminder List. 

1. On Home screen, click Reminders. 
2. To preview, on the shortcut bar, click Preview. 
3. To print, on the shortcut bar, click Print.  
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Viewing Reminders 
 
There are two ways to view reminders: 

• On the Home screen, click Reminders. All reminders appear in the Reminder List. 
• On the Home screen, click the Calendar tab. Reminders are grouped in the Reminder box, and an icon 

displays on the calendar to indicate a reminder exists for that date. 
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Work with Grids 

Customize Grids 
 
You can access most of the information stored in HeadMaster via information grids, also called List Views. 
Information grids have two primary purposes: 

• They enable you to find and select specific records. 
• They allow you to view commonly used information without loading individual records. 

 
Grids can be customized to display the fields or columns that you want to see. For example, by default, the 
Assignments grid displays the following default columns: Name, Class Section, Period, Date Assigned, and Date Due. 
However, Mrs. Smith would like to also view the assignment type, such as “homework” or “test” as well as the 
description of the assignment. She can add these columns to her grid and save the custom view. 

1. With your cursor in the grid, right-click your mouse. 
2. On the right-click menu, click Customize. The Customize Grid menu displays the available column names. 
3. Select the field names you want to add to the grid and click OK. 
4. On the toolbar, click Save Current View. 
5. In the Save View dialog box, enter the name of your view. For example, enter "My View." 
6. Click OK. 

 

 

 

 

  

You can also customize the grid colors. 
1. On the Home screen, click Options. 
2. In the options list, click Custom Colors. 
3. Select a pre-made color scheme from the drop-down list or select your own colors from the sample grid. 
4. Click Close. 

  

  

  

  

Useful Information:  
• You can click and drag the field name to thee place on the grid where you want it displayed.  
• To resize the column, place the cursor on the line between two fields. Click and drag the border to 

the desired width. To automatically adjust the width to fit the data in the column, place the cursor 
on the line between two field and double-click the mouse.  
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Filter by Form 
 
When you need to filter a list using three or more fields, use the Filter by Form option. 

1. On the toolbar, click Filter by Form. The Filter by Form dialog box displays. 
2. Select the items you want to filter for.  
3. Click OK. The grid displays the record type you selected. 
4. To print the filtered view, on the toolbar, click Print. 
5. To clear the filter, on the toolbar, click Clear Filter.  
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Filter by Selection 
 
To obtain a quick view of the records you want to see based on one or two fields, use the Filter by Selection option. 
To highlight the selection or type of records you want to view, click a cell that contains the record selection. 

1. On the toolbar, click Filter by Selection. The grid displays the record types you selected. 
2. To filter the grid again, repeat steps 1 and 2 as many times as necessary. 
3. To print the filtered view, on the toolbar, click Print. 
4. To clear the filter, click Clear Filter.  
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Filter Grids 
 
If you want to minimize the types or number of records you can see in the grid, you can filter the records so that you 
can find just what you are looking for. 
 
There are two ways to filter grids: 

• Filter by selection 
• Filter by form 

 
If you want to filter only one or two fields, use the Filter by Selection to obtain a quick view of the records you want 
to see. However, if you need to filter three or more fields, use the Filter by Form method to eliminate redundant 
keystrokes. 
 
To print the filtered view, on the toolbar, click Print.  
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Open Saved Views 
 
After you save one or more views, you can switch between various grid views. 

1. On the toolbar, click Open Saved View. 
2. Select the view name you want to see and click OK.  
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Save a View 
 
You can save a view you use often so it can be opened again at a later time. 

1. On the toolbar, select Save Current View. The Save View dialog box displays.  
2. In the dialog box, enter the name of your view. For example, enter “My View.” 
3. Click OK.  
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Sort Grids 
 
Information can be sorted by any field in the grid in ascending or descending order. 

1. Click the column heading. 
2. To reverse the sort order, click the column heading again.  
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Search in a Grid 
 
You can search within a grid for specific information.  

1. Click the column heading name. 
2. Enter letters or numbers in the Search for text box located above the grid. 
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Save a Grid as a File 
 
As an administrator, you can export data from HeadMaster and save it in a file. You can also save an information grid 
as a webpage (.htm, .html), text comma delimited (.txt), or comma delimited (.csv) file. 
 

 
To save a grid  

1. On the Home screen, click the type of information grid you want to export (Students, Parents, Teachers, etc.)  
2. Customize the list view and filter or sort the criteria as needed.  
3. On the shortcut bar, click Save to File. 
4. In the Save in list, select a location to save the file. 
5. Enter a name in the File name field. 
6. In the Save as type list, select a file type. Example: .htm, .html, .txt, or .csv. 
7. Click Save. 

  

  

   

Useful Information: You can export specific records in the order you want by filtering for specific criteria, and then 
sorting in the desired order prior to exporting the data. The data is exported using the current sort order and filter 
criteria. 
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Search for Information 

Build a Search Query 
 

A query is a question or inquiry. When you create a search, you have a question in mind. To answer the question, you 
need to know what information to enter into a search before you can get the correct information out of a search. 
Decide what information you are looking for and break it into manageable pieces or fields. 
 
For example, you need a list of all female students with a GPA greater than 3.5 so that you can recognize them at this 
year's graduation. Start the search by breaking the information down. You need to perform a search that isolates the 
following characteristics: 

• The individuals must be students. 
• The students must be females. 
• The students must be graduating May of the current school year.  
• The students must have a GPA greater than 3.5. 

 

Now that you have broken this down into distinct items, you can create this query. 

Conditions further define a field in a search. Conditions contain three parts: 
• Field – Search for any field in HeadMaster. Examples of fields are First Name, Current GPA, Locker Number, 

or Immunization Date Due. 
• Operator – Use mathematical expressions such as greater than, less than, equal to, not equal to, ends with, 

starts with, and contains. 
• Value –Enter a specific representation for the field. For example, if the field is Grade Level, a value is K5. 

 
To build a search query 

1. On the Home screen, click Searches. 
2. Click New. 
3. On the General tab, in the Name field, enter Female Honor Graduates. 
4. Click the Type list and select Student. 
5. Click the Criteria tab. On the toolbar, click the Toggle And Or until the Query condition is And. 
6. Under Fields, expand Individual and double-click Gender. 
7. Click the Operator list and select Is Equal To. 
8. Click the Value list and select Female. Click OK. 
9. Repeat steps 6, 7, and 8 for each of the remaining parts of the query. 
10. For Field, select Active Student; For Operator, select Is Equal To; and for Value, select Female. 
11. For Field, select Current GPA; For Operator, select Is Greater Than; and for Value, enter 3.5. 
12. For Field, select Graduation Date; For Operator, select Is Equal To; and for Value, enter 5/31/2013. 
13. On the toolbar, click Process Search. 

 

 

  

  

  

  

Useful Information: You must have at least one field (or criterion) selected to perform a search. These fields are 
strung together using AND / OR statements. Each Operators and Values are limitations upon the field. Possible 
Operators are: Is Greater Than, Is Equal To, Is Not Equal To, Starts With, Ends With, and Contains. Values can be 
anything that a specific field can be worth. By adding conditions (fields with operators and values), you can 
structure a search to find exactly what you are looking for.  
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Create and Save a Search 
 

When you create and save searches, you're building a search list that contains queries that you can use over and 
over. From the Search window, you can view, add, change, delete, and print the results of searches or queries on 
your data. 

1. On the Home screen, click Searches. 
2. Click New. 
3. On the General tab, enter a descriptive name that relates to the results of the search. The search criteria will 

be saved by the name you enter here.  
4. To select a type from the search list, click the Type list.  
5. To help identify a saved search later, enter a Description.  
6. Click the Criteria tab. 
7. On the toolbar, click the condition And or Or. To create a search that requires two or more criteria, click And. 

To create a choice between two criteria in the search, click Or. When using Or, you can search for one 
criterion or another, but not both. 

8. To enter conditions, double-click a field. In the Fields list, select a mathematical expression that compares the 
field with the value and enter or select a value. 

9. To add other conditions, repeat step 6. If you need to remove conditions, in the toolbar, click Clear Criteria. 
10. To view the results of the query, click Process Search on the toolbar. 

 

 
 

  

Useful Information: 
• If you search Parent type, you can also include Secondary Parents (for students with blended families) in 

your search results.  
• When building queries, you may need to change the condition set in step 7 above. To change an And to 

Or, or an Or to And, select the condition. One the toolbar, click Toggle And Or. 
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Create and Save Commonly Used Searches 
 

Searches provide all the tools you need to filter your data and find specific information for use in reports, 
communications, and extracts. You can combine multiple sets of criteria for complex searches. 
 
You can perform a search to locate and return records of students, teachers, parents, classes, other people, alumni 
and staff members with something specific in common. When you search in HeadMaster, you enter criteria that 
narrows the search to the information you are looking for. Once you select the criteria, you can view the results 
instantly. Searches automate the process of looking at each record to find those that match your criteria. The search 
results that are returned can be used to print reports. You can also export search results for use in other programs. 
 
The following are examples of situations when searches can be used to find the information needed: 

• A local camp is planning a retreat for girls in middle school to take place over the summer. You want to make 
sure all of your middle school girls receive a mailer about the camp. This search is performed with student 
data. 

• You are planning a Spring Festival for the school and you need parents to help run it. You need to print a 
listing of all parents who have volunteered to help at school functions. This search is performed with parent 
data. 

• You need a list of all teachers who have a master’s degree or Ph.D. to send to your governing body for 
accreditation. This search is performed with teacher data. 

• A prospective student is inquiring about college prep classes your school offers to students entering high 
school as freshmen. This search is performed with classes data. 

• You need a list of active staff members who are also parents. This search is performed with staff data. 
• The Junior League is sponsoring a luncheon for women who serve as board members of non-profit schools 

and organizations in the area. You want to make sure the female board members at your school receive 
information on the luncheon. This search is performed with other people data. 

• Your school promised a tuition discount for all new students who pre-enrolled in May 2013. You need a list 
of these individuals so you can apply the discount to their tuition. This search is performed with pre-enrolled 
data. 

• A group of investors wants to build a drug rehabilitation facility two blocks from your school. There is going 
to be a town meeting in two weeks to discuss the issue, but only individuals who live in the 29505 ZIP code 
area may attend the meeting. You want to make sure that the families in that area are informed of the 
situation and the upcoming meeting. This search uses family data.  
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Locate People 
 

To locate individuals, such as students, parents, teachers, prospective, or other, on the Home screen, click Locate. 
1. On the Locate toolbar, click View Type, and select the type of individual you want to locate. 
2. In the Locate field, enter the first few letters of the person you want to find. Headmaster highlights the 

name. 
3. To view or edit the individual’s record, double-click the individual’s name. 
4. To delete the individual from the data, click Delete on the toolbar. 
5. To add an individual, click New. 

 

 

 

  

Useful Information: If the Home screen is not displayed, in the Shortcuts menu, click Locate. The Shortcuts menu 
is located by default to the left of the window.  
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Print Reports 

Set Up and Print a Report 
You can print reports that contain important information about your school and students. A wide variety of options 
are available for each type of report. Additionally, administrators can set security options for individual reports, 
thereby limiting the information that other users can view. On the Home screen, or on the Main Menu, click Reports. 
 
You can also copy a report and customize it to display the information that you want on it. Once you copy a report, 
you can make it private or public. A private report can only be viewed by the individual who made it private. 
 

After you select a report, you have the option of using search, sort, filter and miscellaneous options to customize or 
limit the data that is sent to the report. Report options differ depending on the type of report you select.  
 
If necessary, you can customize the printer and page settings for a particular document. Make the changes you want, 
and the default settings will return automatically once the document is closed. 

1. Under Report List, select a report. 
2. Set the search and filter options you want. 
3. Click Print. 
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Save Order by Selections in Grades Reports 
 
You may need to customize reports to meet the needs of your organization. For example, creating a list of entries 
(each with a saved order of classes) can help you run your Student Report Cards more quickly. 
 
To save the class sort order 

1. On the Home screen, or on the Main Menu, click Reports. 
2. In the Report List, select Grades. 
3. Under Grades, select one of the following reports: Student Report Cards, Progress Report, Skill Grades - 2 

Column, or Skills Report. 
4. Click Order by, and then click New. 
5. Enter a description, such as High School. 
6. Under Sort Type, select Class. 
7. Add classes to the right-side column in the order you want them to display in the report. 
8. Click Save. 
9. Your selections are saved as an entry in the Class Sort list that you can use later. 

 
 
 

 

 

 

 

 

 

 

 

 

  

  

  

Note: If you make a copy of the report, your class sort order will be saved in the report copy. 
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Adjust Report Margins 
 
If you have problems with information being cut off of your reports, you can adjust your printer margins. 

1. On the report toolbar, click Setup.  
2. Adjust margins and click OK.  
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Set Up School Contact and Term Information to Print on Reports 
 
An administrator should enter the term and school’s contact information in Options so that it will properly display on 
reports and correspondence. See also Add Your School Logo to Reports and Report Cards on the next page. 
 

 
1. On the Home screen, click Options. 
2. Click School Info. 
3. Under Term, enter a Description, such as “School Year (2017-2018).” 
4. Under contact, enter the contact information.  
5. Enter the address. 
6. Click Close.  

Useful Information: Canadian clients –To display the Canadian format to social security numbers, you must type 
either Canada or CA in the country field.  
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Add Your School Logo to Reports and Report Cards 
 

If you add your school’s logo to the HeadMaster database, you can print the logo on report cards and other official 
documents or reports. You must have an image file located on your computer or a removable storage device. Once 
added, the logo automatically appears on report cards. 

1. On the Home screen, click Options. 
2. Click School Info. 
3. Under School Logo, click Add. 
4. In the Browse window, locate the file that contains the school logo image. 
5. Select the image and click Open. The image will display under School Logo. 
6. Click Close. 
7. On the Home screen, click Options. 
8. Click School Info. 
9. Under School Logo, click Remove. 
10. Click Close.  
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Export the Report to a File Format 
 

Using Print to File, you can export a report to a destination on your hard drive. The report can be posted as a web 
page, imported in another software program, emailed, or saved as an image file. The following file formats are 
supported by HeadMaster: 

• BMP stands for Bit-Mapped graphics format and is the standard for graphics files. You can save a report as a 
BMP, which is an image, in order to insert the report into a Microsoft® Word® document. For example, save 
a report card as a BMP and insert it into a document to show an example of what your report cards look like. 

• HTML stands for Hyper Text Markup Language, the authoring language used to create documents on the 
World Wide Web. You could save a report card as a HTML file and post it on you school's web page to show 
students and parents what their report cards will look like and perhaps explain the format. 

• PDF stands for Portable Document Format, which makes it possible to send formatted documents and have 
them appear on the recipient's monitor or printer as they were originally formatted. To view a report saved 
in PDF format, you need Adobe® Acrobat Reader® which ships on the Headmaster CD-ROM. 

• RTF stands for Rich Text Format and is an interchange format for exchange of documents between 
Microsoft Word and other systems. For example, save the Family List report as an RTF so that you can make 
changes or manipulate the text on the report in Microsoft Word or Notepad before distributing the report to 
office employees. 

To export the report 
1. On the Report toolbar, click Print to File. 
2. To set the location to save the file, click Browse. Navigate to the folder where you want to save it and click 

Save. 
3. Click the File Type list and make your selection. 
4. To view the file prior to export, click Preview. Otherwise, click Export. The file will be saved to the location 

you specified.  
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Copy Reports 
 
Occasionally, you may need to create or customize a report so that it meets the needs of your organization. You can 
copy a report, edit it using Report Builder, and save it for later use. 

1. On the Home screen, or on the Main Menu, click Reports. 
2. Select a report and click Copy. 
3. Enter a name for the report and click OK. To edit the report, double-click the report name to open it in 

Report Builder.  
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Edit the Statement Report to Print on Pre-Printed Statement of Account Forms 
 

You can edit the Statement report with Report Builder so the statement will print on the ACS pre-printed Statement 
of Account form. 

1. On the Home screen, or on the Main Shortcuts menu, click the Reports icon. 
2. Under Billing, click Statement. 
3. On the toolbar, click Copy. This makes a copy of the report that you can edit. 
4. In the Copy Report dialog box, enter a new name for the report, and click OK. 
5. To open the report, double-click the report you want to open. 
6. In the report, under Group Header[ 1 ]: FamilyID, press and hold the Shift key and click each of the following 

six fields to select them: 
• Due Date 
• Description 
• Check No. 
• Date Paid 
• Amount 
• Balance 

7. Press the Delete button on your keyboard. 
8. On the File menu, click Save. 
9. On the File menu, click Close. This returns you to the HeadMaster Reports window. 
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Understand Report Builder Basics 
 
Before you can make any changes to the default reports, you must first make a copy of them. Click to highlight a 
report and click the Copy button on the toolbar. Give the report a name (this will print as the title). With your copied 
report highlighted, click the Edit button on the toolbar to open the Report Builder program. 
 
The basic steps listed below will be applicable to all reports. Please keep in mind the fields that are available to add to 
a report will be dependent upon the type of report you are editing (student, parent, family, class, etc.). 
 
To delete fields, while in Edit mode, click the field you don't want, and press Delete on your keyboard. If the report 
you're editing has multiple tabs, it's possible that unwanted fields will be located on them. You'll need to check each 
tab to ensure that everything is removed. 

1. On the toolbar, click the  Label button. 
2. Click the area in which you want the field to print. 
3. In the field above the ruler, enter your data. 

4. On the toolbar, click the  RichText button. 
5. Click the area in which you want the field to print. 

6. On the toolbar, right-click the  RichText button and select Edit. 
7. Enter your data. 
8. On the main menu, click File > Close. 

9. Click on the box you want to resize. 
10. Place the mouse over one of the small circles, hold the left mouse button down, and move it left/right or 

up/down. 

11. Click on the box that needs to be moved to another location. 
12. Hold the left mouse button down, and move the box left/right or up/down. 

13. Click on the first box you want to move. 
14. Press Shift on the keyboard and click all other boxes that you want to move. 
15. Hold the left mouse button down, and move the box left/right or up/down. 

16. Click on the box you want to change. 

17. Use  to adjust how the text will print. 

18. On the toolbar, click the  DBText button. 
19. Click the area you want the field to print. 
20. Select the data field you want from the drop-down list. 

 

 
  

Useful Information: The field options you see vary depending on the type of report you are editing.  
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An added step must be performed if you want to add information to a report that is outside the original data design. 
For example, you can add parent names to a student report (such as Student Address List). The following procedure is 
provided as an example: 

1. On the toolbar, click the  SubReport button. 
2. Click the area where you want the field to print. 
3. Right-click and select Parent Width. 
4. Resize the box as needed. 
5. Click the empty drop-down list above the ruler and select Family. 
6. Repeat steps 1 through 6 but select Parents. Place the Parents sub-report directly on top of the Family sub-

report. 
7. Click the SubReport Family tab and remove all three empty spaces by dragging the gray divider lines up to the 

top. Place your mouse above the word Summary and drag it up to Detail. Place your mouse above the word 
Detail and drag it up to Title. 

8. Click the SubReport Parents tab, and in the Detail pane add your database fields. 
 

 

  

Useful Information: When creating title headings, follow the steps to add a title or single line of text and place the 
title in the title field. For any areas not in use, follow the instructions in step 7 to remove blank spaces.  
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Use Mailing Labels 

Print Mailing Labels 
 

HeadMaster supports several commonly used Avery® labels for printing addresses, name badges, and name tags. 
The following labels are available: 
 

  

 
There are two parts to printing labels: 

• Setting up the label data 
• Setting up the label layout 

 
When setting up the label data, you can select to print labels for a group of individuals, such as all students, or all 
parents, or you can use a previously saved search or create a new search to use to print labels based on specific 
criteria.  
 
Setting the label layout means to select from a list the fields you want to print on the label, such as a student’s 
address, date of birth, medications, or other information. Also, prior to printing, it is helpful to preview the labels to 
make certain that they look the way you want them to. 
 
To print mailing labels 

1. On the Home screen, or on the Main Menu, click Reports. 
2. On the Reports List, double-click Labels. 
3. Select the Avery label stock you want to print. 
4. Under Label Data, click the Label Type list and select the name of the group for which you want to print 

labels. 
5. If you want to sort the labels, for example to have them print in alphabetical name order, click the Sort by 

list and select a field to sort by. 
6. The Search Type list displays saved searches for the group you selected in Label Type. Click the Search 

Type list and select a saved Search Type. 
7. To select a saved search, click the Search list and select a search name. If you don't have a saved search, 

click New Search. For help creating searches, see Create and Save Commonly Used Searches on page 31. 
8. Under Label Layout, click each Line and select the fields you want to print on the label. To print the field 

name, select Show Title. To print custom text, select Text and enter the text you want to print on the 
label. 

9. Also, under Label Layout, you can select Show all Families to print all families. If the Show all Families 
check box is clear, only primary families will print. 
10. Click Print. 

 

Report Description 

Address (Avery 5160) Prints a sheet of address labels using Avery 5160 labels. 

Address (Avery 5161) Prints a sheet of address labels using Avery 5161 labels. 

Address (Avery 5260) Prints a sheet of address labels using Avery 5260 labels. 

Address/Shipping (Avery 5163) Prints a sheet of address labels using Avery 5163 labels. 

Address/Shipping (Avery 5164) Prints a sheet of address shipping labels using Avery 5164 labels. 

Name Badge (Avery 5395) Prints a sheet of name badges using Avery 5395 labels. 

Name Tag (Avery 5385) Prints a sheet of name tags using Avery 5385 labels. 

Rolodex (Avery 5386) 3 " x 5" rotary cards. 

Rolodex (Avery 5388) Prints 3" x 5" index cards. 
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Set up label layout 
 

1. In the report list, double-click Labels and select a label style. 
2. Click the Label Type list and select Student. 
3. Click Sort by and select a field of your choice. 
4. Click Search Type and select Student. 
5. Click New Search. 
6. On the General tab, in the Name field, enter Active Students. Click the Type list and select Student. 
7. Click the Criteria tab. 
8. Under Fields, expand Student and double-click Active Student. 
9. In the Condition dialog box, click the Operator list and select Is Equal To. Click the Value list and select 

Yes. 
10. Click OK. 
11. On the toolbar, click Process Search. 
12. Click Close. 
13. To close the Search window, click OK. 
14. On the Labels View window, click the Search list and select Active Students. 
15. Select the Label Layout you want and click Preview. 
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Set up label data 
 

1. In the report list, double-click Labels and select a label style. 
2. Click the Label Type list and select Student. 
3. Click Sort by and select a field of your choice. 
4. Click Search Type and select Class. 
5. Click New Search. 
6. On the General tab, in the Name field, enter First Grade. Click the Type list and select Student. 
7. Click the Criteria tab. 
8. Under Fields, expand Student and double-click Grade Level. 
9. In the Condition dialog box, click the Operator list and select Is Equal To. Click the Value list and select 

01. 
10. Click OK. 
11. Click Process Search. 
12. Click Close. 
13. To close the Search window, click OK. 
14. On the Labels View window, click the Search list and select First Grade. 

15. Select the Label Layout you want and click Preview. 
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Generate and Log Correspondence 

Set Up SMTP Settings 
 

In order to send email or mass email through correspondence, you must enter the default SMTP server settings in 
HeadMaster. Before you begin, obtain the server and port settings from your Internet carrier or system 
administrator. You will also need your username and password. 

1. On the Home screen, click Options. 
2. Click SMTP Settings. 
3. Enter the server name and port name. 
4. To force the user to log on to the outgoing email server, select the Authenticate check box. If you select 

this option, the user will be prompted to log on when he connects to the specified server. 
5. Select the Use SSL check box to encrypt the email. 
6. Enter your username and password. 
7. Enter the school email address. This will function as the default email address for replies unless a reply 

email is set up under Settings. 
8. Enter a standard signature in the text box. 
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Set Up Mass Email Settings 
 

To use the mass email feature in HeadMaster, you must set up email account information and your system 
administrator must set up SMTP information. The information entered under settings is the personal email settings 
for each teacher, administrator, or staff member in the school. The SMTP settings are school-wide and should be the 
same for everyone. 

The email settings under User Settings override the email settings under SMTP settings. For example, if a teacher 
prefers email responses to be delivered to her personal mailbox instead of the school's general mailbox, the teacher 
should enter an email address for replies under Settings. The replies will be sent to the teacher instead of the email 
address set up in the SMTP settings. 

1. On the Home screen, click Options. 
2. Click Settings. 
3. Under Mass E-mail Settings, enter the username and password for your email account. If you don't know 

these settings, contact your system administrator. 
4. To have replies sent to a different email address, such as a general school inbox, enter the alternate email 

address in the E-mail Address for Replies field. 
5. In the Signature text box, enter the name, title, or other information you want to be applied to the bottom 

of each mass email.  
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Send a Mass Email 
 

After you create or edit correspondence, you can email it to multiple recipients from within HeadMaster. The 
advantage of using HeadMaster to send correspondence via email is that you can log the email on the individual's 
Communication tab so you can reference it at a later time. 

Prior to sending correspondence via email: 
• Set up mass email settings. For more information, see Set Up Mass Email Settings on page 47. 
• Enter SMTP server settings. For more information, see Set Up SMTP Settings on page 46. 
• Create or edit the correspondence. 
• Filter the correspondence recipient list. 

To send a mass email 
1. On the Home screen, click Correspondence. 
2. Double-click the correspondence you want to send and click E-mail. 
3. The From field is automatically populated with your school's name. You can edit this field. The name in 

the From field appears in the recipient's inbox. 
4. In the Subject field, enter a description of your email. 
5. The username and password default from the settings entered in the mass email settings and SMTP 

server settings. You can enter an Email Address for Replies if they should be sent to a different address, 
such as a teacher assistant's email address. 

6. In the Signature field, enter your name and title as it should appear in the email. You can leave this blank if 
you've already included this in your correspondence. 

7. To send the email, click Next. 
8. After HeadMaster sends the mass email, it displays a list of individuals who didn't receive the email and 

the reason for the failure. 
9. Click Close. 
10. The Log Printing/Email dialog box displays. Enter the information and click Save Log. 

 

 
  

Useful Information: When you are emailing documents that are longer than one page, you should use the Attach 
File option. For OnDemand users, we recommend that you not send a file that exceeds a 1.75M. Desktop users 
should contact their email provider to find out the recommended maximum file size.  
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Send an Email to an Individual 
 
You must have an email program, such as Outlook® or Thunderbird™ installed on your computer and you must have 
Internet access. You can look up and send an email to any individual in your data. This method sends a single email to 
one individual. 

1. On the Home screen, click Students, Parents, Teachers, Staff, Prospective, or Other People. 
2. Double-click the individual you want to send an email to. 
3. Click the Phone tab. 
4. If there is more than one email address, click to select the one you want to use. 
5. Click the Send E-mail button. 
6. Your default email application opens with the email address you selected filled in. Enter your message and 

click Send. 
 

  

Useful Information: You can also send an email to an individual from anu list view of individual records. On the 
toolbar, click Send E-mail. 
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Edit and Delete Correspondence 
 

You can edit and delete letters you composed in Correspondence. 
1. On the Home screen, click Correspondence. 
2. Select the letter you want to edit or delete and click Edit or Delete. 
3. If deleting, a confirmation dialog box displays. Click Yes. If editing, revise the document as needed and 

click OK. 
4. HeadMaster automatically saves the document for use within the program. To save the letter for use in 

another program, on the File menu, click Save As. In the File Name box, enter a name for the file and click 
Save.  
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Filter Correspondence Recipients 
 

There are two ways to filter the list: 

• The first filter starts with a list of individuals based on the Document type you selected. It can be narrowed 
by removing individuals from the list that shouldn't receive the correspondence. For example, if the 
document type is Students, then students appear in the filtered list and individual students can be added to 
the list. 

• The second filter is based on saved search criteria. These criteria can be set up and saved by clicking 
Searches. Use this filter method when the list of recipients is more complex than a general group of 
individuals. For example, you may want to send a letter to active senior students or to the parents of 4K 
children with no immunization records. 

 

To filter the list of potential recipients of the correspondence 
1. On the Home screen, click Correspondence. 
2. Double-click the correspondence you want to filter, and click the Filter/Search tab. 
3. Select Print only these individuals in the list and click Select. The Select Individual dialog box displays. 
4. In the Search for field, enter the name of a student you want to add and click the Student Name. 
5. Click OK. 
6. Continue this process until all names for the correspondence have been added to the list. 
7. Click OK. 
8. On the Home screen, click Correspondence. 
9. Double-click the correspondence you want to filter, then click the Filter/Search tab. 
10. Select Print only these individuals in the list and click Search. 
11. Click the Search list and select the search you want to use. Click OK. 
12. All individuals that fit the search criteria display. Select any you don’t want to send correspondence to, 

then click Remove. 
13. Click OK. 

 
When selecting recipients in the Correspondence window, teachers can filter the class roster to display the names of 
students in a particular class. First, create the correspondence you plan to send to parents or students. In the 
Correspondence window, the Document Type must be Parent or Student. Save your correspondence. For more help 
creating correspondence, on the Home screen, click Correspondence. When the Correspondence List window 
opens, on your keyboard, press F1 to view online help. 

1. On the Home screen, click Correspondence. 
2. Double-click the letter or email you want to send. 
3. Click the Filter/Search tab. 
4. Select Print only these individuals in the list. 
5. Click Select. 
6. In the Select Class list, select the class. 
7. Click OK. 
8. You can then select individual students and click Remove to delete them from the correspondence list; or, 

to add additional classes, click Select and repeat steps 6 and 7. 
 

 
 

  

Useful Information: This feature is available for those using a Teacher Login.  
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Activate the Correspondence Log 
 

The Correspondence Log keeps a record of letters or email sent to individuals. When you print a letter or send email 
to an individual, a log of the correspondence appears on the Communications tab for that individual. Before you can 
track correspondence in the log, though, you must activate the correspondence log. 
 

 

1. Click Settings. 
2. Under Log Settings, select Log Correspondence Print Activity. 
3. Click Close.  

Useful Information: The Log Correspondence feature only applies to letters and emails produced in the 
Correspondence window.  
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Delete the Correspondence Log 
 

You can delete the log for all existing correspondence or for correspondence within a specific date range. 
1. In the File menu, select Mass Change. 
2. Expand Individual and select Correspondence Log. 
3. Under Select Date, select All Dates or Date Range. 
4. Click Delete.  
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Insert a Field in Correspondence 
 

You can insert Headmaster data fields in new or existing correspondence in order to merge personal information with 
a form letter. For example, if you're typing a letter to all parents of 4K students, you can enter fields that'll merge the 
parent's name, mailing address, and student's name with your standard text. 

1. On the Home screen, click Correspondence. Create a new letter or edit an existing letter. 
2. Field names are located to the right of the editor in the Fields For dialog box. To insert a field name in the 

body of the letter, double-click the F ield Name or click the name and Insert Field. 
3. To save changes and close the editor, click OK.  
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Print Correspondence 
 

After you create or edit correspondence, you can print a copy for each recipient. Once printed, HeadMaster prompts 
you to log the correspondence on the individual's Communication tab so you can reference it at a later time. 

Prior to printing correspondence, you must: 
• Create or edit the correspondence 
• Filter the correspondence recipient list 

 

To print 
1. In the Correspondence window, click Print. 
2. In the Printer Name list, select a printer. 
3. Select the option that best describes the pages you want to print. 
4. Enter the number of copies of each letter you want to print. For example, if you enter 2, two copies of each 

letter will print. 
5. Click OK. 
6. The Log Printing/Email dialog box displays. Enter the correspondence information, then click Save Log.  
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Set Up Correspondence 
 

You can compose letters, email, or other document types with the Correspondence tool. Be aware that when you're 
emailing documents that are longer than one page, you should use the Attach File option. We recommend to not 
exceed a 5MB file size. 
 

 
1. To create a new letter or email, click New. 
2. Enter a name and description for the correspondence. Click the Document Type list and select a type. 

Enter notes in the Notes field. 
3. To open the editor, click Create. Type a letter in the editor, inserting data fields as needed. 
4. To save your changes and return to the correspondence list, click OK. HeadMaster automatically saves the 

document for use within the program. To save the letter for use in another program, on the File menu, 
click Save As. In the File Name field, enter a name for the file. Click Save. 

5. To generate the letter, click Print or E-mail, depending on what you want to do with the document. One 
letter will be created for each individual who is a member of the group selected in Document Type. For 
example, if you selected Student, then a letter will be generated for each student. If you would like to filter 
the recipient list, click the Filter/Search tab. 

6. To close the Correspondence window, click OK. You may return to the Correspondence window to edit 
letters and emails at any time. 

 

 

  

  

  

Additional Field Descriptions 

Copy to Sender 

Do Not Copy  – The default selection. The sender receives no email copies 

Carbon Copy (1 per E-Mail)  – The sender receives a carbon copy of each email. 

Blind Carbon Copy (1 per E-Mail)  – The sender receives a blind carbon copy of each email. 

Copy original message to sender  – The sender receives a single copy of the email, even if there are multiple recipients. If the sender created the  
email message using text fields, the sender receives a copy of the email containing the default text fields. For example, if the sender inserted the Birth  
Date field in the email message, the email copy will contain <dbtext>Birth Date</dbtext> instead of each email recipient's actual birth date information. 

Useful Information: If you log in as a teacher, you’ll be able to correspond with other teachers and staff, but under 
Student and Parent correspondence, you’ll be able to select only students enrolled in your class and the parents 
associated with them.  
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Manage ZIP Codes 
 

A list of frequently used ZIP Codes are stored in HeadMaster to help minimize repetitive data entry. ZIP Codes are 
automatically added to this list each time a ZIP Code is entered for an individual. You can also add to this list 
manually. Additionally, you can set a default ZIP Code to be used in the absence of the user entering one. The 
default ZIP Code should be the most frequently used one. 

When you enter a default ZIP Code, HeadMaster automatically uses the ZIP Code in the absence of a user entering 
one. If necessary, the user can type over the default ZIP Code when entering data. 

1. On the Home screen, click Options. 
2. Click Default ZIP Code. 
3. Enter the ZIP Code information and click Close. 

You can add a new ZIP Code to a list of frequently used ZIP Codes. ZIP Codes are also added to this list 
automatically if a ZIP Code is entered on an individual record. 

1. On the Home screen, click ZIP Codes. 
2. Click Add. 
3. Enter the information associated with the ZIP Code. 
4. Click OK. 

Because ZIP Codes are automatically added to the list of frequently used ZIP Codes, you should occasionally review 
the list and do some housekeeping. You can edit or delete ZIP Codes from this list. 

1. On the Home screen, click ZIP Codes. 
2. Double-click ZIP Code. 
3. Change the ZIP Code information and click OK.  
4. On the Home screen, click ZIP Codes. 
5. Select a ZIP Code and click Delete. 
6. When the confirmation message displays, click OK.  
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Background Checks 

In today's world, it's important to know exactly who is volunteering, serving, working, and caring for your church or 
school family. That's why we've partnered with Verified First to bring you comprehensive, detailed, and convenient 
background checks.  

Background Checks features include: 
• A secure online application. Protect applicants by allowing them to enter their personally identifiable 

information at their convenience. You can launch email invitations straight from the product and reports 
sync back to individual profiles. 

• Additional controls over staff rights. Choose who can submit background checks, view results, or do both. 
• Pay one bill, not two. We’ve consolidated billing, so you’ll receive just one statement from ACS 

Technologies. 
• Comprehensive results. Verified First offers several background check packages to fit your church's needs. 

All packages include a Nationwide Criminal Search and Social Security Number trace. 
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Sign up for Background Checks 
 
If you're new to background checks in HeadMaster, you must sign up for a Verified First account. Your church only 
needs one Verified First account- every staff member who requests or reviews background checks use this account.  

To sign up for a Verified First account 
1. Log into HeadMaster as an administrator. 
2. On the Home screen, click Other People, Parents, Staff, or Teachers. 
3. Double-click an individual’s record. 
4. On the Safeguard tab, click Request Background Check. 
5. Complete and submit the online agreement for service to Verified First. 

Verified First will contact you to review it and process the agreement, and they will send you an email update when 
finished. After Verified First processes your agreement, you can request background checks.  
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Create Safeguard Task Descriptions and Statuses 
 

Safeguard Tasks let you manually track your background check process and results. Tasks consist of Task 
Descriptions and Task Statuses. 

• Task Descriptions describe tasks you're tracking related to background checks. For example: Signed Consent 
Form, Drive Church Vehicle, and Work with Children might be task descriptions.  

• Task Statuses describe the results. For example, Yes, No, Pending, and Restrictions Apply could be task 
statuses. 

 

You can enter comments for each task, which is helpful if you want to enter notes related to background checks or 
their results. You can also track dates on tasks, which is helpful if you want to track when a background check was 
completed so you'll know when to request a new one. 

1. On the Home screen, click Define List. 
2. Under Safeguard, select Task Description. 
3. Click Add. 
4. Enter a task description and click OK. 
5. On the Home screen, click Define List. 
6. Under Safeguard, select Task Status. 
7. Click Add. 
8. Enter a task status and click OK.  
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Add a Safeguard Task 
 

Once you've created Safeguard task descriptions and statuses, Safeguard Tasks let you manually track your 
background check process and results. 

On the individual's Safeguard tab, you can add new Safeguard tasks and edit existing ones. For example, if an 
individual returns a signed consent form, you can update the individual's record to reflect that is was returned and 
include the date. You can review tasks and the comments associated with them at any time.  

Administrators have full access to the Safeguard features and can grant Safeguard rights to users within User 
Administration. 

To add a Safeguard task 
1. On the Home screen, click Other People, Parents, Staff, or Teachers. 
2. Double-click an individual’s record. 
3. Click the Safeguard tab. 
4. Click Add. 
5. In the Task Description drop-down list, select a defined description or choose <New> to enter a new 

description. 
6. In the Status Description drop-down list, select a defined description or choose <New> to enter a new 

description. 
7. If the task is a completed one, enter a date in the Date Completed field. 
8. If you want to add comments to the task, enter them in the Comments field. 
9. If you want to add another task, select Add Another. 
10. Click OK. 
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Request Background Checks 
 

On the Safeguard tab, you can request background checks on individuals through HeadMaster in partnership with 
VerifiedFirst. Once a background check is complete, you can view the results. You can also add tasks to track an 
individual's background checks and the results. 

To request a background check 
1. On the Home screen, click Other People, Parents, Staff, or Teachers. 
2. Double-click an individual’s record. 
3. Click the Safeguard tab. 
4. Click Request Background Check. You will be redirected to Verified First, a separate Web application used for 

the background checks.  
5. If prompted, enter your Verified First Username and Password in the fields, click Log In. To save your 

username and password, select Remember Me.  
6. When the order form displays, verify the applicant's personal information, which is uploaded from 

HeadMaster. 
7. In the drop-down list, select the appropriate Package based on which background check you're requesting. 
8. To email the applicant a link to consent to and complete the background check, click Send Invite. To enter the 

background check information yourself, click Next. 
9. If you enter the background check information yourself, enter any required information in each step, then 

click Next. If the information is on the applicant's individual record in HeadMaster, it displays in the fields.  
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Review Background Check Results 
 
With adequate security rights, you can review background checks you have requested to see the status, individual 
who ordered the background check, date completed, and full details of the results. 

To Review Background Check Results 
1. On the Home screen, click Other People, Parents, Staff, or Teachers. 
2. Double-click an individual’s record. 
3. On the Safeguard tab, click Review Background Checks.  
4. In the Review Background Checks window, select the result you want to view, then click View. 
5. If prompted, enter your Verified First Username and Password in the fields and click Log In. If you want to 

save your username and password, select Remember Me.  
6. After you log in, expand the Complete tab to view background checks results. 

After reviewing the full results, you can use Safeguard Tasks to enter and track when an individual had a background 
check and any other information about the results. Staff members who do not have full access to request and review 
background checks within Verified First can view these tasks, dates, and comments.  
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Background Check Documents and Consent Forms 
 

Federal law requires that an individual give his or her signed consent to perform a background check. You can obtain 
this electronically and create customized forms for your organization. 

When requesting a background check inside Verified First, you can send individuals an electronic form to verify 
information and consent. This protects applicants by allowing them to enter their personally identifiable information 
at their convenience. 

1. On the Home screen, click Other People, Parents, Staff, or Teachers. 
2. Double-click an individual’s record. 
3. On the Safeguard tab, click Request Background Check. You will be redirected to Verified First.  
4. If prompted, enter your Verified First Username and Password in the fields, click Log In. To save your 

username and password, select Remember Me.  
5. When the order form displays, verify the applicant's Personal Information, which is uploaded from 

HeadMaster. 
6. In the drop-down list, select the appropriate Package based on which background check you're requesting. 
7. To email the applicant a link to consent to and complete the background check, click Send Invite. 
8. Read the certification message that displays, select the checkbox, and click Send. 

Here are some sample consent forms that you can customize to suit the needs of your organization. For example, 
you can tailor a form to ask potential volunteers which area they want to volunteer in, include fields for contact 
information, and add your organization's logo to the form.  

If you create customized forms, you may want to reach out to your legal team to ensure they are still compliant to 
use.  
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Manage Custom Fields 

Add a Custom Field 
 

You can define custom fields for students, parents, teachers, classes, alumni, or prospective students. 

For example, you may want to track locker combinations for students. These fields are called “custom fields.” You 
can add, edit, and delete custom fields, but you can also lose data if changes are made to an existing field. 
 
When you add custom fields in options, the fields display on the Custom tab for the type of individual you selected 
during set up. 
 

 
 

1. On the Home screen, click Options. 
2. Click Custom. 
3. Click the Type list, and select an individual type (Student, Teacher, etc.). The custom field displays on the 

individual window for the type you select. 
4. Click Add. 
5. Enter the custom field properties.  
6. Click OK. 

 
 

Additional Field Information 

When you add a custom field, you can name the field, set the type and length of the data that can be entered in the field, create a Value list that the user 

can search values in, set a default value, and mark the field private. 

Field Name — Enter a descriptive field label. Examples: College, Highest Degree, Year Graduated from College, Married, Number of Children, 

and Alumni Pledge. 

Field type — The field type limits the type of data that can be entered. 
Text — This is the default field type. Text can be words, numbers, or a combination of both. Example: Clemson University, A1-B5-H78. 

Currency — Dollar amounts. Example: $10.00 or .50. 

Date — Displays dates in the format of MM/DD/YYYY. 

Real Number — Includes rational and irrational numbers, such as decimals and integers (natural numbers, negative numbers, and zero). 

Whole Number — A positive integer, such as 1, 50, 100. This field type will not accept negative numbers. 

Yes/No — This places a check box in the custom field that the user selects or clears. Example: Married is a yes/no field. The Custom tab 

displays a check box that is selected for yes, or cleared for no. 

Field Size — To limit the number of characters that can be entered, enter a positive number. Example: If your locker combinations have a 

standard number comprised of 10 digits, set the field size to 10. 

Category — If you have more than one custom field, enter categories to organize the fields. Example: The custom fields are categorized by 

College, Family, and Financial. 
Default Value — Enter a selection that will automatically be used by the program in the absence of a choice made by the user. 

Private Field — To prevent this field from printing on reports, select this check box. 

Uppercase — To force uppercase letters, select this check box. 

Lookup Values — To build a list of values that will appear in a Value list, enter each value with a return after it. On the Custom tab, this field will 

have a Lookup Values list that the user can select from. 
Must Choose Value from List — If selected, the user is required to select a value from the list. If clear, the user can enter a value in the field. 

  

  

  

  

Useful Information:  
• If you want custom fields to display in the grid view for each type of individual, on the Home screen, click 

Options > Settings. Select Allow Custom Fields in Main Grids. Be advised that this slows the loading of 
the grid view.  

• When adding custom fields, close all current grids containing the field type you’re adding. For example, if 
you’re adding student custom fields, the Student grid must be closed.  
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Change a Custom Field 
 

You can change a custom field to be tracked for students, teachers, parents, staff, or classes. This could result in the 
loss of data if you change a field containing existing data. 

1. On the Home screen, click Options. 
2. Click Custom. 
3. Double-click the custom field that you want to change. 
4. Change any of the information. 
5. Click OK.  
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Delete a Custom Field 
 

You can delete a custom field to be tracked for students, parents, staff, or classes. 
1. On the Home screen, click Options. 
2. Click Custom. 
3. Select the field you want to remove and click Delete.  



 

Copyright © 2014, ACS Technologies 69 

Use the Calendar Tab 

Add Reminders on the Calendar Tab 
 

You can set up and edit reminders on the Calendar tab or in the Reminder List. However, you can only delete 
reminders from the Reminder List. 

After you set up reminders, they display on the HeadMaster Calendar tab, and the calendar displays a small icon on 
the date the reminder is set. 

1. On the Home screen, click the Calendar tab, located at the bottom of the screen. 
2. On the date you want to add a reminder, right-click, point to Add > Reminder. 
3. Enter the reminder information. 
4. Click OK. 
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Edit a Reminder or Mark a Reminder Complete 
 

You can edit reminders in HeadMaster after they've been entered. 
1. On the Home screen, click the Calendar tab, located at the bottom of the screen. 
2. Double-click the reminder you want to change. 
3. Make your changes to the reminder. 
4. To mark a reminder complete, select the Completed check box. 
5. Click OK.  
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View Assignments (Teachers) 
 

Teachers can add and edit assignments on the Calendar tab. However, assignments can only be deleted from the 
Assignments List. 

After you add assignments to the program, they appear in the assignments area of the Calendar tab and are 
highlighted on the calendar. 

1. On the Home screen, click the Calendar tab, located at the bottom of the screen. 
2. Under Assignments, double-click the assignment you want to view or edit. 
3. To close the assignment, click OK.  
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View Individuals Currently Checked In 
 

Administrators can view all individuals who are currently checked in. 

To view all individuals currently checked in, on the Home screen, click the Calendar tab (located at the bottom of the 
screen). 
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To View Today's Attendance 
 

Administrators can view the current day's attendance for all teachers who have posted it. 

To view the current day's attendance, on the Home screen, click the Calendar tab (located at the bottom of the 
screen).  
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Create Lists 

Set Up an Activity List 
 

You can define activities and apply them to students, parents, teachers, or classes. HeadMaster contains some 
predefined activity lists, but you can customize the lists to suit your needs. 

Once you set up activity lists, they display on the Activity tab of the student, parent, teacher, or class record. 

Add an activity 
1. On the Home screen, click Activities. 
2. Select Student, Parent, Teacher, or Class. 
3. Click Add. 
4. Enter a name for the new activity. 
5. Click OK. 

Update the name of an activity 
1. On the Home screen, click Activities. 
2. Select Student, Parent, Teacher, or Class. 
3. Under List of Available Activities, double-click the description you want to change. 
4. Change the name of the activity. 
5. Click OK. 

Delete an activity 
1. On the Home screen, click Activities. 
2. Select Student, Parent, Teacher, or Class. 
3. Under List of Available Activities, click the description you want to remove. 
4. Click Delete. 
5. When the confirmation message displays, click OK. 
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Set Up Individual Lists 
 

You can customize several types of lists that apply to all individual types. These lists include: 
• Address types (home, vacation, other) 
• Church affiliations (Baptist, Presbyterian, Catholic) 
• E-mail types (home, school, business) 
• Phone types (fax, pager, mobile) 
• Race (American Indian, Caucasian, Hispanic, African American) 
• Relation (grandparent, brother, sister, mother, father) 
• Suffix (Jr., Sr., III) 
• Title (Rev., Dr., Mrs., Mr., Miss) 

 

For general information about how you can use Define Lists to customize data entry for your organization’s specific 
purposes, see Customize Program Options and Lists on page 83.  
 
Create a list 

1. On the Home screen, click Define List. 
2. Under Individual, select the list type (Address Types, Church Affiliation, etc.) that you want to create. 
3. Click Add. 
4. Enter a description. 
5. Click OK. 

Edit a list 
1. On the Home screen, click Define List. 
2. Under Individual, select the list type (Address Types, Church Affiliation, etc.) that you want to edit. 
3. In the list of available types, double-click the description that you want to change. 
4. Enter a new description. 
5. Click OK. 

Delete a list 
1. On the Home screen, click Define Lists. 
2. Under Individual, select the list type (Relation, Suffix, Title, etc.) that you want to edit. 
3. In the list of available types, click the description you want to remove. 
4. Click Delete, and Yes. 
5. Click OK.  
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Edit an Individual's General Information 

Change an Individual Phone Number 
 

Individual numbers are unique numbers used to identify the individual, whether a student, parent, teacher, staff, 
other, or prospective. These numbers are located on the General tab of the individual’s record. 

1. On the Home screen, click Students, Parents, Teachers, Staff, Other People, or Prospective. 
2. Double-click an individual’s record. 
3. On the General tab, change the Individual #. 
4. To save changes, click OK. 
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Change an Individuals' Active Status 
 

You can change the active or inactive status for individuals or for a group of individuals, such as students, parents, 
teachers, or staff. For more information about activating a group of individuals using Mass Change, see Activating or 
Deactivating a Group of Individuals. For information about deactivating a family, see Deactivate a Family or Family 
Members.  
 

 

Activate or reactivate a student 
1. On the Home screen, click one of the following individual icons: Students, Parents, Teachers, Staff, 

Prospective Students, Alumni, or Other People.  
2. Double-click the individual’s record. 
3. Click the General tab. 
4. Select the Active check box. (Depending on the individual type, this may be labeled “Active Student,” “Active 

Contributor,” etc.) 
5. Clear the check boxes for any classes that you don’t want to reactivate the student in.  
6. Click Close, then OK.  

 
Deactivate an active student 

1. On the Home screen, click one of the following individual icons: Students, Parents, Teachers, Staff, 
Prospective Students, Alumni, or Other. 

2. To select the individual’s record, double-click the name. 
3. Click the General tab. 
4. Clear the Active Student check box. 
5. To enter the Date Deactivated, click the lookup button and select a date. 
6. Click OK.  

Note: If you are activating a student who has classes, the student will be re-activated in all of the classes unless 
you clear the class check boxes in the Confirm dialog box. 
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Change a Preferred Name 
 

A preferred name is the name that an individual wants to be called. For example, a student named Alexander, may 
like to be called Alex instead. You can edit the name that a student, parent, teacher, staff, prospective, or other 
prefers to be called. 

1. On the Home screen, click one of the following individual icons: Students, Parents, Teachers, Staff, 
Prospective Students, or Other People. 

2. Double-click the individual’s record. 
3. Click the General tab. 
4. Change the Preferred Name. 
5. Click OK.  
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Immunization Records 

Store Immunization Records 
 
Immunizations are the preventative shots students receive on a schedule to inoculate them against infectious 
diseases and illnesses. Using HeadMaster, you can track the immunizations that are important to your school, state, 
or district. HeadMaster contains the names of many standard inoculations already entered, but you can customize 
this list. 

When immunizations are entered on the prospective or student record, dates are associated with them. Therefore, 
instead of entering a series of shot names in the Immunization List (such as Hepatitis 1, Hepatitis 2, and Hepatitis 3), 
enter Hepatitis only once in the Immunization list. Then, on the prospective or student record, add Hepatitis and 
associate three different dates with the immunization. 

To add or edit an immunization 
1. On the Home screen, click Immunizations. 
2. To add an immunization, click Add. 
3. To change an immunization, click Edit. 
4. Enter or edit the name of the immunization. 
5. Click OK. 
6. When you're finished setting up immunizations, click OK. 

To delete an immunization 
1. On the Home screen, click Immunizations. 
2. Click the immunization you want to remove from the list. 
3. Click Delete. 
4. Click OK. 
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Add Immunization Records 
 

After you set up or revise an immunization list for your school, you're ready to add immunization information, such as 
the name of the vaccine, the date received, and date due to the prospective and student records. 

1. On the Home screen, click Students or Prospective Students. 
2. Double-click on an individual’s name. 
3. Click the Immunizations tab. 
4. Click Add. 
5. Click the Immunization drop-down list, then select a vaccine. 
6. Click Add. 
7. Enter the date. 
8. Click OK.  



 

Copyright © 2014, ACS Technologies 81 

Edit or Delete Immunization Records 
 

You can edit or delete immunization information from a prospective or student record. 

To edit an immunization record 
1. On the Home screen, click Students or Prospective Students. 
2. Double-click on an individual’s name. 
3. Click the Immunizations tab. 
4. Click Edit. 
5. Change immunization information. 
6. Click OK. 

To delete an immunization record 
1. On the Home screen, click Students or Prospective Students. 
2. Double-click on an individual’s name. 
3. Click the Immunizations tab. 
4. Click to select an immunization record and click Delete. 
5. Click Yes. 
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Update Immunization Records 
 
After you set up or revise an immunization list for your school, you're ready to track the dates those immunizations 
are received by the students. 

1. On the Home screen, click Students or Prospective Students. 
2. Double-click on an individual’s name. 
3. Click the Immunizations tab. 
4. Select an immunization from the grid, then click Edit. 
5. Click Add. 
6. Enter the date, then click OK. 

 

 

  Useful Information:  
 
Current statuses of each immunization you will see in the grid 

• Completed – All immunizations in the series have been given. 
• Overdue – Required immunizations are out of date.  
• Not Set Up – Required immunizations have not been assigned. 
• Missing DOB – NO date of birth is entered for the selected student. 
• Current – Required immunizations are up to date.  
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Update Immunizations for Multiple Students 
 

The school nurse or other administrator can mass add or remove specific immunizations using the Manage feature. 

1. On the Home Screen, click Immunizations. 
2. Select the immunization you want to add or remove and click Manage. 
3. If you intend to update prospective students’ immunization records, as well, select Include Prospective. 

The All list will update to include their names. 
4. Select students from the All list to apply the change to and click Add (or double-click the name). To remove 

students from the Selected list, select them and click Remove (or double-click the name). 
5. When finished selecting students, click OK. 

 

 
  

Useful Information: On your keyboard, press and hold Ctrl to select multiple students, or press and hold Shift to 
select blocks of students. You can also use Add All or Remove All to assign or delete an immunization for the 
entire list.  
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Customize Program Options and Lists 

There are ways to make data entry more efficient and to customize the HeadMaster program so that it contains lists 
or data specific to your organization. In many cases, you can create or customize lists of items that display in 
HeadMaster. For example, you can set up various address, phone, and email types such as home, business, or 
alternate. You can customize lists of church affiliations, name suffixes and titles, races, and people relationships to 
suit various geographical or cultural differences represented in your community or school. 

An overview of program options and defined lists is provided below. However, specific program options and lists are 
explained in further detail in other sections of this user guide. In addition, to get help with setting up options and 
defining lists, press the F1 key on your keyboard from any option or define list window.  

• To view or set up defined lists, on the Home screen, click Define Lists. 
• To view or customize options, on the Home screen, click Options. 

 
Use Define List to customize HeadMaster to better suit your organization's needs. Define List displays a tree-view 
list of available fields that are used in lists throughout HeadMaster. 

Although HeadMaster contains default lists, you can customize these lists by adding, editing, or deleting items 
contained in them. 

To view the Define Lists window, on the Home screen click Define Lists. 

Select the option you want to enter a value for. Click Add, enter the value indicated and click OK. 

The HeadMaster Options window contains a list of items that should be set up prior to using the program. For 
example, Options is where you store default school information and the school logo, SMTP Settings for connecting 
to your email or the Internet, skill codes, department names, and more. To view the Options window, on the Home 
screen, click Options. 
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Change Your Password 

You can change your password at any time. 

To change your password 
1. On the Tools menu, click Change Password.  
2. Or, on the Home screen click Change Password. 
3. Enter the requested password information and click OK.  
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HeadMaster Import 

The purpose of the HeadMaster Import process is to reduce your amount of manually keyed data and save you hours 
of time at the keyboard. You can use the import process to pull names, addresses, as well as multiple other 
categories of student contact data from .csv or .xml import files into  
HeadMaster. To ensure the import process works properly, your import file should contain separate columns for 
each data category. For example, each data category such as Last Name, First Name, Date of Birth, etc. should have 
its own column. 
 
The imported data does not overwrite your existing data. It only adds students to your existing database. For 
example, if you have John Smith entered in HeadMaster, and then you add his data with a new import, you'll have 
two entries for John Smith within your database. 
 
Useful Information: To use the HeadMaster Import process, you must have created a backup of your program data 
within the past 2 days.  
 
Importing data into HeadMaster is accomplished through mapping (or linking) fields in your import file with the 
appropriate fields in HeadMaster. The procedure below will guide you through the process. 

1. Open the HeadMaster Import. 
a.) Windows 7: On your Windows desktop, click the Start button  in the lower-left corner of the screen. 

The Start menu displays. Click All Programs > HeadMaster > HeadMaster Import. Log in with your 
username and password and click OK. 

b.)Windows 8.1: On the Windows desktop, click the Start button  in the lower-left corner of the screen. 
The Start screen displays. Click  

the arrow button . The Apps view displays. In the HeadMaster section, click HeadMaster Import. Log in 
with your username and password and click OK. 

c.) Windows 10: On the Windows desktop, click the Start button  in the lower-left corner of the screen. 
The Start menu displays. Scroll to the HeadMaster section and click HeadMaster Import. Log in with 
your username and password and click OK.  

2. The HeadMaster Import dialog box displays. Click the  ellipses button and browse to the file that you 
want to import. 

3. Select whether the imported data is for enrolled or prospective students. 
4. In the Data View section, verify that you are importing the correct data. 
5. Click Next. 
6. Click and drag each Source Field category from the left column to an equivalent category in the right 

column. In this step, you're mapping the fields. Click       to expand other data categories that you may want 
to map and import.  

7. If your import file is one that you'll use more than once, you can click Save Map in the upper-right corner 
of the window. You'll be prompted to provide a name for your new map file. In the future, you can access 
your saved map files by clicking Load Map whenever you're in this window. 

8. Click Finished. 
 

 
Once you've imported your data, you should verify that it imported correctly. If the import results are incorrect, you 
can correct any issues in the import file; restore the last backup that you made; and then run the import process 
again. 
  

Useful Information: The Last Name is the only required field for import. Any record that doesn’t have a last name 
is imported and given the last name “Converted (no last name).” 
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Activate or Deactivate a Group of Individuals 

When multiple individuals need to be deactivated or activated, you can save time by using the Mass Change feature. 
1. On the File menu, click Mass Change. 
2. Double-click Individual. 
3. Click Individual Types. 
4. In the Select Type drop-down list, select Student, Parent, Teacher, or Staff. 
5. Click a name to select an individual. To select multiple individuals, on your keyboard, press and hold Ctrl 

while clicking individual names. To select a block of individuals, click the first name in the block, press and 
hold Shift, and then click the last name in the block. 

6. Select either Activate or Deactivate. 
7. Click Change. 
8. To confirm, click Yes. 
9. Click OK.  
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HeadMaster SchoolCast™ Export 

In an effort to maximize the effectiveness of communication between schools and parents/faculty, HeadMaster has 
partnered with SchoolCast™ by High Ground Solutions. What does this mean for you? 
 
SchoolCast offers a rapid communication solution for schools needing to immediately inform targeted groups of 
people about things such as student events, school closings, faculty meetings, etc. With SchoolCast, you can even 
schedule automatic phone calls regarding attendance issues and lunch balances. 
 
Taking advantage of these great features involves exporting your HeadMaster data to the SchoolCast Notification 
System. Headmaster has made this task as easy as possible through the use of an export process which guides you 
one screen at a time through creating an export file with customizable fields. 
 
To export HeadMaster data to SchoolCast 

1. Go to your HeadMaster directory (Example: C:\HMaster) and double-click the SchoolCast Export.exe file. 
2. The first screen of the wizard displays. Click Next and proceed through each screen. 
3. On the last screen, click Export. 

  
HeadMaster OnDemand users can set up the SchoolCast export as a scheduled task. You might want to consider the 
scheduled task especially if you already run other tasks on a regular schedule. 
 
Before scheduling the export, you must run the export manually the first time in order to select and save the export 
settings you want. 
 

To schedule the HeadMaster data export to SchoolCast through OnDemand 
1. On the OnDemand overlay menu, double-click the SchoolCast Export icon. 
2. The first screen of the wizard displays. Click Next and proceed through each screen. 
3. On the last screen, click Export. 
4. After the export, on the OnDemand overlay menu, double-click the Schedule Tasks icon. 
5. The Scheduler dialog box displays. Click Add. 
6. The Schedule a Task dialog box displays. On the drop-down menu, select SchoolCast Student/Staff Export. 
7. Select the time and days you want the scheduled task to run and click OK. 
8. The Scheduler dialog box displays. On the schedule grid, verify the SchoolCast schedule and click Close. 
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Implement New School Year Procedures 

The annual preparation for a new school year is a major task for your school, and it’s important that your school 
performs that task well every year. There are a number of HeadMaster procedures that you can use to ensure that 
your school is properly prepared for the new school year. 
 

 

 
 

Useful Information: At beginning of a new school year, you may find it necessary to create a new, empty 
database.  

Note: You must have performed your promotions to the new school year before implementing the new school 
year procedures.  
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New School Year Procedures 

Set up the School Information 
 

The first procedure is setting up your term description. 
1. On the Home screen, click Options. 
2. In the Term section, enter the new school year in the Description field. Example: 2012-2013 
3. Click Close.  
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Set Up Grading Period Dates 
 

To have correct attendance totals appear in HeadMaster and on the student report cards, you must set up the 
grading period dates for the new school year. 

1. On the Home screen, click Options. 
2. Click Grading Periods. 
3. From the tabs at the bottom of the screen, click a grading period. 
4. Click Set Dates. 
5. For each period, enter a Start Dates and End Dates. 
6. Click Close. 
7. If needed, select another Grading Period. 
8. After you enter all the dates you want, click Close.  
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Upload HeadMaster Online Grading Period 
 

If you use HeadMaster Online, you need to select the appropriate grading period to be uploaded. 
1. On the Home screen, click Options. 
2. Click HM Online. 
3. In the Active Period section, select the appropriate grading period. 
4. Click Close.  
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Upload a New Data Set for HeadMaster Online 
 

If you use HeadMaster Online and have been using scheduled automatic uploads, you must select a new data set to 
upload. 

1. On the Home screen, click Options. 
2. Click Scheduled Tasks. 
3. In the Automated Upload Settings, select the new data set. 
4. If you are using HeadMaster Lunch and would like to automatically import preorders, select the Import 

Lunch Preorders check box.  
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Enroll Prospective Students 
 

If you have been using Prospective Students to manage the waiting list for new students to your school, you must 
move those students to the Active Student list. You can enroll one student at a time or multiple students at the same 
time. 

Enroll a student 
1. On the Home screen, click Prospective Students. 
2. Double-click the student you want to enroll. 
3. Click the Enrollment tab. 
4. Ensure the Status information is complete. 
5. Click the Enroll Now. 

Enroll multiple students 
1. On the Home screen, click Prospective Students. 
2. Select multiple students while pressing Shift or Ctrl on your keyboard. 
3. On the icon toolbar, click Actions. 
4. Click Enroll.  
5. Click OK.  
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Enter New Students 
 

The Add Student Assistant provides a convenient way for you to enter new students. 
1. On the Home screen, click Add Student. 
2. Enter the student's information. 
3. Click Next. 
4. Select Enter new family information. 
5. Click Next. 
6. Enter the Primary Family Information. 
7. Click Next. 
8. If there is no secondary family, select None. If secondary family information is available, select Enter new 

family information. 
9. Click Next. 
10. Enter secondary family information (If applicable). 
11. Click Next. 
12. Enter emergency contact and pickup information. 
13. Click Finish.  
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Assign Homeroom Teachers 
 

You have the ability to mass assign homeroom teachers if you have not retained homeroom teachers during the 
promotion process. You can move groups of students from one homeroom teacher to another, or you can select 
different students for each homeroom teacher. 
 
To move groups of students from one homeroom teacher to another 

1. On the Home screen, click File. 
2. Click Mass Change. 
3. Click to expand Students. 
4. Click Homeroom Teacher. 
5. In the Options section, select Search and Replace. 
6. In the Value to Change field, click the drop-down arrow and select the current homeroom teacher. 
7. In the New Value field, click the drop-down arrow and select the new homeroom teacher. 
8. Click Change. 
9. Click Yes. 
10. Click OK. To change more homeroom teachers, repeat steps 5-10. 
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To select different students for each homeroom teacher 
1. On the Home screen, click File. 
2. Click Mass Change. 
3. Click to expand Students. 
4. Click Homeroom Teacher. 
5. In the Options section, click Select Individual. 
6. Click Select. The Select student dialog box displays. 
7. Click the Grade Level column header. 
8. Select multiple students while pressing Shift or Ctrl on your keyboard. 
9. Click Add. 
10. Click OK. 
11. In the New Value field, click the drop-down arrow and select the new homeroom teacher. 
12. Click Change. 
13. Click Yes. 
14. Click OK.  
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Enroll Students in Classes 
 

You can enroll multiple students into multiple classes at the same time, or you can do student schedules one at a 
time. 

1. On the Home screen, click Student Schedule. 
2. Select a scheduling option. The following procedure steps will assume selecting the first scheduling option. 
3. Click Next. 
4. Select the students you want to create schedules for. Select multiple students while pressing Shift or Ctrl 

on your keyboard. 
5. Click Add. 
6. Click Next. 
7. Select the classes you want to add to the student schedules and click Add. Select multiple classes while 

pressing Shift or Ctrl on your keyboard. 
8. Click Save. 
9. To continue adding classes, click Yes.  
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Set Up the School Calendar 
 

The School Calendar is created using the start and end dates of your grading periods. Before you begin adding 
events or closings to the calendar, ensure your grading periods are set up properly. 
 
To create an event on the school calendar 

1. On the Home screen, click Tools. 
2. Click School Calendar. 
3. Enter the Start Date. 
4. Enter the End Date. 
5. Select the Type. 
6. Select the days the school meets. 
7. Click OK. 
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To choose a calendar type 
1. On the Home screen, click Tools. 
2. Click School Calendar. 
3. On the calendar, right-click a date. 
4. Select the calendar option that you want. (To add more items to the calendar, repeat steps 3-4)  
5. To save the calendar, click OK.  
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To print a calendar 
1. On the Home screen, click Tools. 
2. Click School Calendar. 
3. On the calendar, click Print and select the view that you want to print.  
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Reset Lesson Plans 
 

If your teachers have been using the Lesson Plans feature and you have copied the lesson plans to the new data set, 
you can reset the dates for all teachers' lesson plans.  

1. On the Home screen, click Tools. 
2. Click School Calendar. 
3. Click Reset Lesson Plans. 
4. Enter the date for the first day that the lesson plans begin. 
5. Click Run. 
6. After the lesson plans have been rescheduled, click OK. 
7. To close the school calendar, click OK.  
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Enter New Teachers and Staff 
 

When you add a teacher, a staff record is automatically created. However, when you add a staff person, a teacher 
record is not created. 
 
To add a new teacher 

1. On the Home screen, click Teachers. 
2. Click New. 
3. Enter personal information on each tab.   
4. To save the teacher record, click OK. 
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Set Up the Lunch Calendar 
 

You can customize a weekly or monthly lunch calendar by adding items to days in Lunch Calendar. 
1. On the Home screen, click Lunch. 
2. Click Lunch Calendar. 
3. Click the calendar arrows to select a month. 
4. Click a calendar date. 
5. In the Menu Items column, double-click each menu item that you want to add. You can also right-click a 

calendar date and add the menu items in that manner. 
6. To add multiple menu items at the same time, select them while pressing Shift or Ctrl on your keyboard 

and then click Add Item to Selected Day. 
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Copy a lunch calendar 
1. On the Home screen, click Lunch. 
2. Click Lunch Calendar. 
3. Click a calendar date. 
4. Click Copy/Paste, and then click either Copy Day or Copy Week. 
5. Click the calendar date to which you want to copy the menu items. 
6. Click Paste. 
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Delete a menu item on a lunch calendar 
1. On the Home screen, click Lunch. 
2. Click Lunch Calendar. 
3. Click a calendar date and click the menu item you want to delete. 
4. Click Delete, and then click Delete Item. Click Clear Day to delete all the menu items for the selected day.  
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Change Billing Code Amounts 
 
Your tuition and registration may increase each year. However, you do not need to enter new billing codes. You can 
simply edit the existing billing codes with the new price. 

1. On the Home screen, click Define List. 
2. Click to expand Billing. 
3. Click Billing Codes. 
4. Click the billing code you want to edit. 
5. Click Edit. 
6. Change the amount. (To edit more billing code amounts, repeat steps 4-6) 
7. Click OK. 
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